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Chapter 1: Before you begin

Before you begin working with Adobe® Flash® Media Encoder, take a few moments to read the following 
overview of the Help and of the many resources that are available to users.

Help components
Help The documentation is available in Help. To access it, select Help > Flash Media Encoder Help.

PDF version of Help To view all the Help topics in a single document, download the PDF from the download center 
at www.adobe.com/go/learn_fme_main_en or the Adobe Help Resource Center at 
www.adobe.com/go/learn_fme_doc_en.

Command-line help To show a list of all the command-line parameters and their usage, open a command prompt in 
the Flash Media Encoder installation directory and enter the following:

FMEcmd /h

Using Help
The following topics describe how to use Help for Flash Media Encoder.

Browse Help topics
In the navigation pane, do one of the following:

• To browse by topic, click the Contents tab.

• To browse alphabetically, click the Index tab.

Search Help topics
1 In the navigation pane, click the Search tab.

2 Type one or more words in the text box and click the Search button.

Topics that match the search terms appear in the navigation pane, listed in order of relevance.

These tips can help you improve your search results in Help:

• If you search using a phrase, such as “output video,” put quotation marks around the phrase. The search returns 
only those topics that contain all words in the phrase.

• Make sure that search terms are spelled correctly.

• If a search term doesn’t yield results, try using a synonym, such as “web” instead of “Internet.”

Navigate Help
Navigate Help by doing any of the following:

http://www.adobe.com/go/learn_fme_main_en
http://www.adobe.com/go/learn_fme_doc_en
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• Expand items in the Contents tab until you reach the desired topic. To view a topic, click its title in the Contents 
page.

• Click the left or right arrow in the reading pane to go to the previous or next topic.

• Click Back on the toolbar to go to the last page you viewed.

• Click Forward to go to the page you viewed before clicking the Back button.

Resources
Flash Media Encoder Forums This site, at www.adobe.com/go/fme_forum, provides forums for Flash Media 
Encoder users to share information and ideas.

Flash Media Server Support Center This site, at www.adobe.com/go/flashmediaserver_support_en, provides Tech 
Notes and the latest information about Adobe Flash Media Server.

Flash Media Server Developer Center This site, at www.adobe.com/go/flashmediaserver_desdev_en, provides 
articles, tips, and samples for creating Flash Media Server applications.

Flash Video Developer Center This site, at www.adobe.com/go/learn_flv_devnet_en, provides articles, tips, and 
samples for working with Adobe Flash video.

Adobe.com
The following resources are available on the Adobe website:

Adobe Design Center Offers articles, tips, and tutorials in various formats, including video, Adobe PDF, and 
HTML. The content is authored by industry experts, designers, and Adobe publishing partners, and new content is 
added monthly. You’ll also find Adobe Studio Exchange, where users download and share thousands of free actions, 
plug-ins, and other content. Adobe Design Center is available in English, French, German, and Japanese. Visit 
Adobe Design Center at www.adobe.com/designcenter.

Adobe Developer Center Provides samples, tutorials, articles, and community resources for developers who build 
rich Internet applications, websites, mobile content, and other projects using Adobe products. The Developer Center 
also contains resources for developers who develop plug-ins for Adobe products. Visit Adobe Developer Center at 
www.adobe.com/go/developer.

Adobe Help Resource Center Includes complete in-product Help and PDF documentation with updates and 
additions as they become available. For some developer products, Help on the web is provided in LiveDocs format, 
which enables users to add comments to topics. Visit the Adobe Help Resource Center at 
www.adobe.com/go/documentation.

Communities Features forums, blogs, and other avenues for users to share technologies, tools, and information. 
Users can ask questions and find out how others are getting the most out of their software. User-to-user forums are 
available in English, French, German, and Japanese; blogs are posted in a wide range of languages. To participate 
in forums or blogs, visit www.adobe.com/communities.

http://www.adobe.com/go/flashmediaserver_support_en
http://www.adobe.com/go/flashmediaserver_desdev_en
http://www.adobe.com/go/learn_flv_devnet_en
http://www.adobe.com
http://www.adobe.com/go/fme_forum
http://www.adobe.com/designcenter
http://www.adobe.com/go/developer
http://www.adobe.com/communities
http://www.adobe.com/go/documentation
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What’s new?
Flash Media Encoder 2 includes several new features that you can use to automate your encoding and streaming 
operations.

Command-line options Use command-line options to run encoding sessions via scripts or from a command prompt.

MP3 support Encode audio in either MP3 or Nellymoser format. For MP3 format, you can also choose the number 
of channels (mono or stereo).

Timecode support When using a device that can generate timecodes, embed an SMPTE timecode in the video 
stream.

Features for enabling 24/7 broadcasts Several settings and command-line parameters make it easy to run encoding 
sessions continuously. Create scripts and integrate them with your existing automated systems.

Support for remote access Access Flash Media Encoder—in both GUI and command-line mode—via Microsoft® 
Remote Desktop Connection or RealVNC™.
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Chapter 2: Getting started

Flash Media Encoder is a software program for capturing, encoding, and streaming audio and video to Flash Media 
Server or the Adobe Flash Video Streaming Service.

Flash Media Encoder is designed for technical audio/video producers who seek a convenient and simplified 
workflow. It provides a unified interface to audio and video capture devices, basic editing tools, fine control over 
Flash encoding parameters, and live broadcast via Flash Media Server or Flash Video Streaming Service providers. 
Flash Media Encoder can also be run from a command-line interface, making it possible to set up continuously 
running encoding sessions and integrate them with existing automated systems.

For more information about Flash Media Encoder and related products and services, see the following sites:

Flash Media Encoder www.adobe.com/go/learn_fme_main_en

Flash Media Server www.adobe.com/go/fms

Flash Media Solution Provider Program www.adobe.com/go/fmsp

Flash Video Streaming Service www.adobe.com/go/fvss

Flash Media Encoder basics
The following sections describe the basic operations to get you started with Flash Media Encoder.

About GUI and command-line modes
You can run Flash Media Encoder from the graphical user interface (GUI) or from the command line. Some opera-
tions are available in only one of the two modes, and some are available in both modes.

Start the Flash Media Encoder GUI
❖ Do any one of the following:

• Select Start > All Programs > Adobe > Flash Media Encoder 2.

• From a command prompt in your Flash Media Encoder installation directory (typically C:\Program 
Files\Adobe\Flash Media Encoder 2), enter the following:

FMEcmd /g [/p [path\]profile.xml] [/ap userID:password] [/ab userID:password]

The /g parameter starts Flash Media Encoder in GUI mode. For information on the optional /p, /ap, and /ab 
parameters, see “Start Flash Media Encoder in command-line mode” on page 6.

http://www.adobe.com/go/learn_fme_main_en
http://www.adobe.com/go/fms
http://www.adobe.com/go/fvss
http://www.adobe.com/go/fmsp
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About the Flash Media Encoder GUI
The Flash Media Encoder GUI includes a menu, a preview of input and output video, and a control panel where you 
can configure encoding options, view and configure encoding logs, and start and stop encoding sessions.

A. Menus  B. Previews  C. Control panel  D. Control buttons

Previewing video and audio
The preview panel in the Flash Media Encoder GUI includes the following:

• An audio level meter, indicating input audio volume, and a mute button

• An Input display of the video currently being captured

• An Output display, which reflects current video encoding settings

Note: Before encoding starts, the Output display reflects only crop, resize, and deinterlace settings.

By default, the preview panel is active and appears at actual output size.

Show or hide input video, output video, and audio

❖ Select or deselect the following Preview options:

• Input Video
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• Output Video

• Audio

Mute or unmute the audio

❖ Click the speaker icon  in the audio preview.

Adjust the zoom level

❖ Select a percentage from the pop-up menu on the upper right of either the Input or Output preview.

Note: Zoom level does not affect encoding or the stream that viewers see.

Show or hide the control panel

❖ Click the triangle next to the Encoding Options tab.

Start Flash Media Encoder in command-line mode
❖ From a command prompt in your Flash Media Encoder installation directory, enter the following:

FMEcmd [/p [path\]profile.xml] [/l [path\]log_file] [/ap userID:password]

[/ab userID:password] [/t dd:hh:mm] [/r]

Flash Media Encoder launches without displaying the GUI and immediately starts an encoding session.

Encoding and streaming
The following sections describe how to start and stop encoding video, and how to configure an encoding session log.

Start and stop encoding from the GUI
1 Click the Start button at the bottom of the Flash Media Encoder window.

Note: If both the Stream To Flash Media Server and Save To File options in the Encoding Options tabbed panel are 
deselected, the Start button is unavailable.

Parameter Description

/p (Optional) Specifies the path and filename of an XML profile to use. If you do not include this parameter, Flash Media Encoder 
uses the default profile, startup.xml. For more information, see “Saving encoding profiles” on page 14.

/l (Optional) Specifies the path and filename of an encoding log file. For more information, see “Using the Encoding Log” on 
page 7.

/ap (Required if the primary server requires authentication) Specifies an authenticating user ID and password for the primary 
server.

/ab (Required if the backup server requires authentication) Specifies an authenticating user ID and password for the backup 
server.

/t (Optional) Instructs Flash Media Encoder to restart after the specified time interval. For more information, see “Scheduling 
automated maintenance restarts” on page 16.

/r (Optional) Registers the encoding session to restart at an operating system relaunch after a system closure or crash. For more 
information, see “Configuring Flash Media Encoder to launch at system startup” on page 16.
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2 If an authentication dialog box appears, enter your user ID and password.

3 To stop encoding, click Stop.

Note: Although the encoding stops, the server connection persists until you click Disconnect. For information on 
connecting to and disconnecting from the server, see “Connect and disconnect” on page 12.

Starting and stopping encoding sessions from the command line
When you start Flash Media Encoder from the command line, it automatically starts encoding at the same time. For 
encoding sessions that were started from the command line, you can show a list of any running sessions and stop an 
encoding session.

Show a list of encoding sessions that were started from the command line

❖ From a command prompt in your Flash Media Encoder installation directory, enter the following:

FMEcmd /s

Stop an encoding session that was started from the command line

❖ From a command prompt in your Flash Media Encoder installation directory, enter the following:

FMEcmd /s fme_UID

When the session is streaming to a server, use the format fms_URL+stream_name for fme_UID. For example, to stop 
an encoding session that is running on the server fms.myserver.com with the Flash application live, and the stream 
livestream, you would enter the following:

FMEcmd /s rtmp://fms.myserver.com/live+livestream

When the session is being saved to a Flash Video (FLV) file but is not streaming to a server, use the FLV path and 
filename for fme_UID. For example:

FMEcmd /s "C:\Documents and Settings\abc\My Documents\My Videos\sample.flv"

Using the Encoding Log
The Encoding Log provides detailed information on encoding sessions, and is thus an essential tool for trouble-
shooting. If you are trying to resolve an issue with Flash Media Encoder, support personnel may request that you 
examine the screen log or submit a log file. With the Encoding Log, you can view and save logs of encoding sessions 
and view status information about sessions.

In the GUI, the Encoding Log tab appears automatically when encoding starts. During encoding, logged events and 
encoding status messages appear in real time.

The log section on the left side of the panel lists important encoding events, file system events, and error messages 
as they occur. Each event and message includes a timestamp.

The Status section on the right side of the panel shows information on what the video and audio encoders are actually 
achieving, given the current settings and encoding environment. It also lists the total encoding time. This infor-
mation is also useful when you refine your encoding settings for best results. For example, in the Status section you 
can see whether your target bit rates and video frame rate are being achieved, and whether any video frames are 
being dropped.

Enable logging from the GUI

1 Click the Encoding Log tab.



ADOBE FLASH MEDIA ENCODER 2.0
User Guide

8

2 Select Log To File.

3 By default, logs are saved in your My Documents\My Videos folder. To save the log in a different folder, click 
Log Directory and select a folder or create a new one.

When logging is enabled, Flash Media Encoder creates a new log file each time you start encoding. The log filename 
has the following format:

fme_session_yyyymmdd_hhmmss.log

The date and time are the local system date and time. For example, the name of a log file for a Flash Media Encoder 
session that began at 10:30 A.M. on November 5, 2007 would be as follows:

fme_session_20071105_103000.log

Enable logging from the command line

❖ From a command prompt in your Flash Media Encoder installation directory, start Flash Media Encoder using 
the /l parameter in the following format:

FMEcmd /l [path\]log_file

Here path (optional) and log_file are the path and filename of the log file you want to create. If path is not 
specified, the log file is saved in your My Documents\My Videos folder.

For example:

FMEcmd /p c:\Profiles\my_profile.xml /l c:\Logs\my_log.txt

Note: If you include the /l parameter, the log you specify overrides the log preference specified in the XML profile. 
For more information on XML profiles, see “Saving encoding profiles” on page 14.
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Chapter 3: Configuration and 
automation

This chapter describes the many ways that you can optimize video, audio, and output settings in Flash Media 
Encoder. It also describes how to automate startup tasks so that you can stream media continuously, 24 hours a day, 
7 days a week.

Configuring encoding options
You access most options and controls in Flash Media Encoder via the Encoding Options tabbed panel, which 
appears by default when you start Flash Media Encoder. This panel includes options for adjusting video, audio, and 
output settings.

Select a preset bandwidth option
Flash Media Encoder includes the following encoding preset options, which specify video and audio settings that 
are appropriate for your bandwidth.

❖ Choose an option from the Preset menu. Make your selection based on the bandwidth that will be available at 
broadcast time.

Note: If your capture device does not produce video or audio in the preset values, Flash Media Encoder selects the 
closest available value.

About custom bandwidth options
An additional option in the Preset menu, Custom, is selected when you manually adjust any settings. If you are using 
custom settings when you quit Flash Media Encoder, the next time you start the program, it applies your custom 
settings. If you choose a preset option and exit the program, however, any custom settings are lost. For information 
on saving encoding settings for easy retrieval, see “Saving encoding profiles” on page 14.

Configure video encoding options
❖ On the Video side of the Encoding Options tabbed panel, configure any of the following encoding settings:

Video When deselected, the encoding session does not include video.

Device Specifies the video capture device to use. The menu lists any video devices that are attached to the system 
and that are compatible with Microsoft DirectShow®. Click the tool icon  next to a selected device to configure 
its settings.

Preset option Video size 
(pixels)

Video frame 
rate (fps)

Video bit rate 
(Kbps)

Audio format Audio 
channel

Audio sample 
rate (Hz)

Audio bit 
rate (Kbps)

Low Bandwidth (150 Kbps) 176 x 144 15 100 Nellymoser Mono 11025 22

Medium Bandwidth (300 Kbps) 320 x 240 15 200 MP3 Mono 22050 48

High Bandwidth (800 Kbps) 320 x 240 30 650 MP3 Stereo 44100 128
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Size Specifies the video dimensions, in pixels.

fps Specifies the target frame rate.

Crop When selected, activates controls for cropping input video, to create focus or draw attention to a section of 
the image. See “Crop video output” on page 10.

Resize When selected, activates controls for resizing video dimensions for final output. This is useful if your video 
capture device doesn’t provide the output dimensions you require, or if you crop the input video and want to restore 
specific output dimensions. See “Resize video output” on page 10.

Timecode When selected, embeds an SMPTE timecode in the video stream.

Note: It the selected video device is not capable of generating a timecode, this option is unavailable. If the selected 
video device is not a FireWire device, you may need to provide a DLL file in the appropriate format for that device 
in order to embed a timecode. Install the DLL in the FMEInstallDir\Timecode folder (typically C:\Program 
Files\Adobe\Flash Media Encoder 2\TimeCode).

Burn Timecode When selected, the external video device burns a timecode on the video image, and the timecode is 
visible on the Input and Output preview. To configure advanced timecode settings, click the tool icon  next to the 
Burn Timecode box. For information, see “Configure advanced timecode options” on page 10.

Note: If the selected video device can generate a timecode, but does not provide a mechanism to display a timecode 
on the video frame, the Burn Timecode option is unavailable.

Bit rate Specifies the video bit rate in Kbps. Choose a bit rate from the pop-up menu or enter a value from 0 to 
20000.

Deinterlace When selected, activates the video deinterlacing filter, which may improve video quality by applying 
a simple vertical blur. This option is available only when the input video height is greater than 480 pixels or the 
input video width is greater than 576 pixels.

Advanced Specifies advanced encoding options. See “Configure advanced video encoding options” on page 11.

Crop video output

1 In the Encoding Options tabbed panel, select the Crop option.

2 To specify the crop area, do any of the following:

• Drag any of the square handles that appear at the edges and corners of the Input video preview.

• Enter a pixel value in any of the Top, Bottom, Left, and Right boxes.

• Click the up or down arrow next to a pixel value box.

3 To move the crop selection box to another position, place the pointer inside the bounding box and drag.

Note: If overlay is disabled on your graphics card, the square handles and bounding box are unavailable.

Resize video output

1 In the Encoding Options tabbed panel, select the Resize option.

2 To maintain the width and height ratio when adjusting the value of one dimension, select Maintain Aspect Ratio.

3 Enter a pixel value in the Width or Height box, or click the up or down arrow next to the box.

Note: Although PC-based players may accommodate unexpected video sizes and dimensions, specialty players 
(such as cell phone players) have stricter requirements.
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Configure advanced timecode options

1 In the Encoding Options tabbed panel, select the Timecode option. 

2 Click the tool icon  next to the Burn Timecode box.

3 In the Advanced Timecode Settings dialog box, configure any of the following settings:

Vertical Line Number Specifies the vertical line on which the timecode information appears.

Frame Interval Specifies the number of video frames after which the timecode is embedded into the video stream.

Position Specifies the position of the timecode by Row and Column.

Timecode settings are stored in the XML profile. For information on XML profiles, see “Saving encoding profiles” 
on page 14.

Configure advanced video encoding options

Important: Use these options carefully. The settings affect the way that Flash Media Encoder uses your computer’s 
processor and memory. These settings persist until the next time you readjust them.

1 Click the Advanced icon .

2 In the Advanced Encoder Settings dialog box, configure any of the following settings:

Keyframe Frequency Specifies the minimum frequency for inserting keyframes in the output video stream. 
Keyframes are encoded without reference to any other frames in the stream, and they provide a recovery point if the 
viewer's connection is dropped or rebuffered.

Quality Specifies image quality. Depending on the nature of the content (such as static or dynamic) and processor 
capability, this setting can affect the output, as noted in each setting. The Best Quality setting attempts to retain 
image sharpness, but is processor-intensive; if CPU resources become exhausted while encoding, Flash Media 
Encoder compensates by dropping frames. In general, the first setting in this list that your system can support 
without dropping frames is best. To confirm that frames aren’t being dropped, monitor the Status display while 
encoding. For more information on the Status display, see “Using the Encoding Log” on page 7.

Note: This setting may depend on the CPU Usage setting. For example, if you choose Best Quality but set CPU 
Usage to Very Low, Flash Media Encoder will drop frames.

Noise Reduction The encoder attempts to blur what it perceives as unwanted artifacts in the video stream. This 
setting specifies how aggressively to apply the technique.

Note: Noise reduction is a matter of personal preference; do not adjust this setting unless you determine a quality 
advantage.

Datarate Window Specifies how much datarate fluctuation to allow while encoding.

Flash Media Encoder can recognize similarities between adjacent frames. It allocates fewer bandwidth resources to 
encoding sequences that have fewer changes in the frames (such as a sitting interview using a fixed camera), 
reserving the resources for sequences with more motion (such as a sports event). With a larger Datarate Window 
value, Flash Media Encoder holds more data in its buffer—it can process more video frames, resulting in better 
compression. If you believe that the viewers may have suboptimal network connections, you may want to reduce 
this value. Conversely, for encoding streams that are saved to file for local playback only (that is, streams that are 
never transmitted over a network), use the Huge setting.

The best way to determine the practical effects of this setting is through real-world testing of the viewer experience.
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CPU Usage Specifies the CPU resources to allocate to the VP6 video encoder. You achieve best encoding results 
from a dedicated machine. Special circumstances may require that you reserve some processing power for a second 
task.

Configure audio encoding options
❖ On the Audio side of the Encoding Options tabbed panel, configure any of the following encoding settings:

Audio When deselected, the encoding session does not include video.

Device  Lists any audio devices that are attached to the system and are DirectShow-compatible. Click the tool icon 
 next to the device to configure the device’s settings.

Format Specifies an audio format (MP3 or Nellymoser), as well as the Mono or Stereo option.

Sample Rate Specifies the audio sample rate. The pop-up menu lists only the rates that are available for your audio 
capture device.

Bit rate Specifies the audio bit rate, in Kbps. The pop-up menu lists only the rates that are appropriate to the selected 
sample rate.

Volume Specifies the input audio volume level.

Configure file output options
You can use the file output options to stream live video to a server, save an archived Flash Video (FLV) file of your 
broadcast, or both.

1 From the Panel Options menu on the right side of the Encoding Options tabbed panel, select Output.

2 Configure any of the following options:

Stream To Flash Media Server When selected, enables streaming to the specified servers when encoding starts.

FMS URL Specifies the fully qualified URL, or RTMP string, of the primary server. The URL must begin with 
rtmp:// or rtmpt:// and include your server’s domain name and the Flash application to use. You may optionally 
include a specific application instance and port number. For example:

rtmp://fms.myserver.com:80/live/livestream

Here, fms.myserver.com is the Flash Media Server computer host name, 80 is the port number to connect to 
(optional), live is the name of a Flash application on the host (required), and livestream is the instance of the appli-
cation to connect to (optional).

For more information on RTMP strings, see the Flash Media Server documentation.

Backup URL Specifies the fully qualified URL of a backup server and application (optional). If you specify a backup 
server, Flash Media Encoder streams to both servers.

Stream Specifies a name for the video stream.

Save To File When selected, saves the output to a FLV file. Click Browse to specify a different filename and folder.

Note: If you use a filename that already exists in the selected folder, Flash Media Encoder renames the existing file 
so that the newly saved file does not overwrite it. For example, if sample.flv already exists, Flash Media Encoder 
renames it sample.0.flv and saves your new file as sample.flv. If both sample.flv and sample.0.flv exist, sample.flv is 
renamed sample.1.flv, and so on.
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Connect and disconnect
1 To connect to the URLs specified in FMS URL and Backup URL (if used), click the Connect button in the 
Encoding Options tabbed panel.

Note: If the Stream To Flash Media Server option is deselected, the Connect button is unavailable.

2 If the server requires authentication, enter your user ID and password in the dialog box that appears.

Clicking the Connect button establishes a connection to the URLs specified in FMS URL and Backup URL (if used) 
and changes the button label to Disconnect.

3 To disconnect, click Disconnect.

For information on how to start and stop encoding, see “Encoding and streaming” on page 6.

About metadata
In a player application, metadata can be used to show information about the stream, provide searchable keywords, 
and inject useful, human-readable identifiers into the binary stream.

Flash Media Encoder automatically embeds the following metadata elements in the streams and FLV files that it 
creates:

• audiochannels

• audiocodecid

• audiodatarate

• audiodevice

• audioinputvolume

• audiosamplerate

• creationdate

• framerate

• height

• presetname

• videocodecid

• videodatarate

• videodevice

• videokeyframe_frequency

• width

Flash Media Encoder embeds the following metadata in FLV files, but not in Flash Media Server streams:

• duration

• lastkeyframetimestamp

• lasttimestamp

By default, Flash Media Encoder also embeds the following default metadata fields, which you can populate with 
information for your media stream:

• author
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• copyright

• description

• keywords

• rating

• title

You can create your own metadata fields and delete any existing fields.

Note: Metadata is not available in FLV files if Flash Media Encoder terminates abnormally during an encoding 
session.

Add metadata values

1 From the Panel Options menu on the right side of the Encoding Options tabbed panel, select Metadata.

2 Add values to any of the metadata fields. For example, to record a copyright date of 2007, enter 2007 in the 
Copyright metadata field.

Create and delete metadata fields

1 From the Panel Options menu on the right side of the Encoding Options tabbed panel, select Metadata.

2 To add a new metadata field to the list, click the + icon  and enter a field name. Do not add field names that 
are already included in the standard metadata set.

3 To delete an existing field from the list, select the field and click the - icon .

Saving encoding profiles
When you close Flash Media Encoder after running it from the GUI, all of the settings from that session are saved 
in the default encoding profile, startup.xml. The next time you start Flash Media Encoder—either from the GUI or 
from the command line—the settings in startup.xml apply.

The startup.xml file is stored in Drive:\Documents and Settings\username\Application Data\Adobe\Flash Media 
Encoder 2. For example, if your default Microsoft Windows® drive is C and your username is abc, your startup.xml 
file is stored in C:\Documents and Settings\abc\Application Data\Adobe\Flash Media Encoder 2.

Once you determine encoding and streaming settings that work well in your environment, it’s a good idea to save 
them in a custom profile for easy retrieval. This is especially important if you will be running encoding sessions 
from both the GUI and the command line.

For example, imagine that you’re running one encoding session in GUI mode and another in command-line mode. 
You make some changes in the Encoding Options and close the GUI instance. Flash Media Encoder updates the 
startup.xml profile to reflect the changed settings. If you stop the command-line encoding session and then restart 
it without specifying a custom profile, the new session uses the updated startup.xml profile from the GUI session. 
Thus, to avoid unexpected changes to your encoding profile, you may want to use a custom profile whenever you 
run Flash Media Encoder from the command line.

Flash Media Encoder saves the following settings in an XML profile:

• Video and audio encoding settings, except for hardware device properties controlled by Windows or another 
application

• Flash Media Server connection settings, including server URLs and stream name

• File archiving settings, including filename and path
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• Metadata elements and values

• Preview and zoom settings

• Logging settings

Flash Media Encoder does not save the following settings in a profile:

• Hardware device properties. Flash Media Encoder provides access to the properties dialog boxes of your video 
and audio devices, but it cannot prevent or reverse changes made by other applications. To verify that your 
preferred device settings are in place, click the device’s tool icon .

• Deselected settings. For example, if you resize the video output but deselect the Resize option before saving a 
profile, the resized dimensions are not saved.

Save a profile

1 Select File > Save Profile.

2 In the Save As dialog box, enter a descriptive name for the file. Do not name the file startup.xml, because this 
name is reserved for storing settings from the last session.

3 Click Save.

If you use multiple Flash applications, servers, or content distribution network providers, it’s a good idea to save 
a separate profile for each environment.

Open a profile from the GUI

1 Select File > Open Profile.

2 Select a profile from the Open dialog box.

Open a profile from the command line

❖ From a command prompt in your Flash Media Encoder installation directory, start Flash Media Encoder using /p 
in the following format:

FMEcmd /p [path\]profilename.xml

Here path (optional) and profilename are the path and filename of the XML profile that you want to open.

For example:

FMEcmd /p c:\Profiles\my_profile.xml /ap myid:mypassword

If you do not specify a profile in the command line, Flash Media Encoder loads the default profile, startup.xml.

Automating startup tasks
Flash Media Encoder includes several settings and strategies that you can use to make sure that your session streams 
continuously, 24 hours a day, 7 days a week.

Specify reconnection settings
If the network connection is lost during an encoding session, by default Flash Media Encoder attempts to reconnect 
to the server every 5 seconds until the connection is restored. When the network connection is restored, Flash Media 
Encoder resumes encoding. You can adjust the number of reconnection attempts and the interval between attempts 
in an XML profile.
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❖ Open the XML profile that you want to change in an XML or text editor and add the following lines:

<reconnectinterval>

<attempts>num_attempts</attempts>

<interval>interval</interval>

</reconnectinterval>

Here num_attempts is the number of times that Flash Media Encoder should attempt to reconnect and interval 
is the number of seconds that Flash Media Encoder should wait between reconnection attempts. You can use integers 
or decimal values in either parameter, but in num_attempts, decimal values are truncated. For both parameters, zero 
and negative values mean that Flash Media Encoder will not attempt to reconnect. In this case, the log file includes 
a message indicating that Flash Media Encoder did not attempt reconnection.

Scheduling automated maintenance restarts
Flash Media Encoder is certified to run continuously for 7 days. If you plan to run it for longer than 7 days, it’s a 
good idea to schedule an automated maintenance restart at regular intervals. Once Flash Media Encoder has run 
continuously for the amount of time you specify, it automatically stops, restarts, and continues encoding to the same 
session.

Schedule an automated maintenance restart from the XML profile

❖ Open the XML profile in an XML or text editor and add the following lines:

<restartinterval>

<days>dd</days>

<hours>hh</hours>

<minutes>mm</minutes>

</restartinterval>

Schedule an automated maintenance restart from the command line

❖ From a command prompt in your Flash Media Encoder installation directory, start Flash Media Encoder using 
the /t parameter in the following format:

FMEcmd /t dd:hh:mm

For example, with the following command, Flash Media Encoder restarts after 4 days, 10 hours, and 30 minutes:

FMEcmd /p c:\Profiles\my_profile.xml /ap myid:mypassword /t 04:10:30

If the restart interval is specified in the XML profile as well as on the command line, the command-line setting 
overrides the XML profile setting.

Configuring Flash Media Encoder to launch at system startup
Imagine that you intend to run an encoding session continuously, but during the session the computer on which Flash 
Media Encoder is running crashes. As soon as that computer restarts, you’ll want Flash Media Encoder to restart 
and continue encoding in the same session. You can configure Flash Media Encoder to restart automatically at 
system startup by registering the encoding session. Any crash-related errors are noted in the log file when the 
encoding session restarts. For more information on log files, see “Using the Encoding Log” on page 7.
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Register an encoding session

1 If the Flash Media Encoder Launcher is not already included in your Windows Scheduled Tasks, add it:

a In Windows, select Start > All Programs > Accessories > System Tools > Scheduled Tasks.

b In the Scheduled Tasks window, double-click Add Scheduled Task.

c In the Scheduled Task Wizard, click Next, then browse to your Flash Media Encoder installation directory and 
open FMELauncher.exe.

d Select When My Computer Starts and click Next.

e Enter your user credentials and click Next, then click Finish.

2 From a command prompt in your Flash Media Encoder installation directory, start Flash Media Encoder using /r 
as the last parameter in the command. For example:

FMEcmd /p c:\Profiles\my_profile.xml /l c:\my_log.txt /r

Any encoding sessions that are registered for relaunch are noted in the OsLaunch.dat file in Drive:\Documents and 
Settings\All Users\Application Data\Adobe\Flash Media Encoder 2. The Flash Media Encoder Launcher checks 
this file at system startup and launches any registered entries.

Show a list of all registered encoding sessions

❖ From a command prompt in your Flash Media Encoder installation directory, enter the following:

FMEcmd /u

Unregister an encoding session

❖ From a command prompt in your Flash Media Encoder installation directory, enter the following:

FMEcmd /u fme_UID

If the session is streaming to a server, use the format fms_URL+stream_name for fme_UID. For example, to unreg-
ister an encoding session that is running on the server fms.myserver.com with a Flash application named live, and 
the stream livestream, you would enter the following:

FMEcmd /u rtmp://fms.myserver.com/live+livestream

If the session is being saved to an FLV file but is not streaming to a server, use the FLV path and filename for 
fme_UID. For example:

FMEcmd /u "C:\Documents and Settings\abc\My Documents\My Videos\sample.flv"

The entry for the encoding session that you specify is removed from the OsLaunch.dat file in Drive:\Documents and 
Settings\All Users\Application Data\Adobe\Flash Media Encoder 2. At the next system startup, the encoding 
session does not restart.

Configuring Flash Media Server authentication
If you administer a Flash Media Server computer, you may want to require publishers who connect to your server 
with Flash Media Encoder to authenticate with approved credentials. To do this, you can either install and configure 
the Adobe Flash Media Encoder 2 Authentication Add-In or create and configure your own authentication module. 
Using either of these options, you create accounts for users who connect to a server from Flash Media Encoder.
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Configure the Adobe Flash Media Encoder 2 Authentication Add-in
1 Download the add-in from www.adobe.com/go/learn_fms_authaddin_en.

2 Install the add-in on your Flash Media Server computer.

The add-in installs the Server Access Adapter, and the Flash Media Encoder User Management utility, which you 
can use to add, update, remove, and check user passwords.

3 From a command prompt, change to the following directory:

FlashMediaServerInstallDir\conf

4 To show a list of commands for the user management utility, enter the following:

users

Configure a custom authentication module
1 Write a custom authentication module that includes a client-side adaptor DLL and a server-side adaptor DLL. 
Write the adaptors according to the behaviors and guidelines discussed in the following sections.

2 On the computer running Flash Media Encoder, copy your client-side DLL to the FMEInstallDir\AccessModule 
folder (typically C:\Program Files\Adobe\Flash Media Encoder 2\AccessModule).

3 Install the server-side DLL on the computer that is running Flash Media Server.

Client and server adaptor interaction

In every transaction, the server verifies the parameters appended in the query string that the client sends. The server-
side adaptor identifies itself by prepending the following signature substring in each rejection reason string:

'[ authmod=authmod_name ] :'

Initially, Flash Media Encoder identifies the server by its authmod signature and loads the corresponding client DLL 
from the FMEInstallDir\AccessModule folder. For example, if the value of authmod_name is myauth, then Flash 
Media Encoder loads the myauth.dll file. Subsequent interactions between client and server rely on the authmod 
signature. The server’s response determines whether to abort or continue the authentication process. Flash Media 
Encoder verifies the authmod signature and acts as a medium for client-server interaction. If there is any 
discrepancy in the signature, Flash Media Encoder takes the appropriate action.

Authentication requirements

When authenticating, users must provide a username, password, and RTMP string.

Flash Media Encoder can publish to multiple servers. If the servers have different authentication credentials, Flash 
Media Encoder may need to prompt for passwords more than once. To ensure that users enter the correct user ID 
and password, make sure that the password prompt indicates which server is being connected to.

http://www.adobe.com/go/learn_fms_authaddin_en
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